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B. Voc. Semester V

General Education Component
COURSE: S.BVS.5.01/BVT.5.01

ELEMENTS OF DIGITAL DESIGN

Learning Objective: Learn to explore the beauty of digital design software from the
practical to the painterly artistic. In 45 sessions, practice the editing concepts to understand

how Photoshop will help to create successful customized images.

Number of lectures: 45

Unit 1 - Getting started with Photoshop Number of lectures 10

0 Fundamentals of Photos editing softwares

0 What new in photoshop
0 Basics of Images

0 Vector Images

0 Bitmap Images

0 Interfacing with the Photoshop Desktop
0 Working with The Menu Bar and Tool Box

O File and Edit Menus

0 The Image Menu

O The Layer Menu

O The Select Menu

O The Filter Menu

0 The View Menu

O The Help Menu

0 ToolBox

0 New Features in Photoshop
0 Custom Brushes

0 Healing Brush

O Picture Package

0 Web Photo Gallery

O Spell Checking

O Opening Recent Images
O Importing Images

O PDF Image



0 Annotations

0 WIA Support

O Placing Images

0 Optimizing Images

O File Browser

O PDF Security

0 Understanding the Selecting Tools
O Rectangular Marquee

0 Move Tool

0 Lasso Tool

0 Magic Wand

0 Painting and Drawing Tools
0 Editing and Retouching Tools
0 Background Eraser (E)

0 Erasing Image Background Color
0 Guides, Grid and Slices

0 Transform

0 Layers

O Effects

O Filters

0 Using the Color Tools

0 Working with Palettes

O Actions palette

O History Palette

O Swatches Palette

O Brushes Palette
O
Unit 2 - Painting & drawing Tools Number of lectures 8

Using The Brush and Pencil Tool

0 Choosing a Brush Size

0 Picking a Painting or Drawing Mode
0 Setting Opacity And Flow

0 Using Airbrush Mode

0 Blending with the Smudge Tool

0 Loading Brush Sets

0 Working With The Brushes Palette

O Renaming Brush Presets

0 Deleting Brush Presets

0 Working with the Healing Brush

0 Patching Images
O
Unit 3 - Color Management in Photoshop Number of lectures 9



Applying Colors to your Image

0 Using the Color Picker

0 Selecting Colors with the Eyedropper Tool
0 Working with Color Channels

0 Displaying and Hiding Channels

0 Mixing Color Channels

0 Working with the Color Table

0 Using Auto Color

0 Using Special Color Effects

O Inverting Colors

0 Working with Color Thresholds

0 Equalizing Colors

O Posterizing Images

0 Creating a Gradient Map

0 Desaturated Colors

0

Unit 4 - Working with Layers Session 27:

OLayer concepts
Creating New Layers

O Activating a Layer

O Duplicating Layers

O Arranging Layers

0 Working with Layer Locks
0 Deleting Layers

Creating Layer Based Slice

Unit 5 - Using fills & styles Session 31: O

Using the Pattern Stamp Tool

0 Applying Pattern Fills

0 Working with Styles Palette

0 Understanding the Gradient Tool
O Customizing a Gradient

O Applying a Gradient

0 Working with the Pattern Maker
O Creating your Own Patterns

Number of lectures 7

Number of lectures 11



0 Working with the Layer Style Dialog Box
0 Customizing Blending Options

0 Drop Shadow

O Inner Shadow

O Outer Glow

O Inner Glow

0 Bevel and Emboss

Continuous Internal Assessment
Assignments / Project

Mid Term test.

List of Text Books:

O Photoshop(R) 7: The Complete Reference
by Laurie Ann Ulrich (Author)

Photoshop CC:

by Lesa Snider (Author)

List of Practicals:

Experiment 1. Moving objects from one layer to another using layer properties.
Experiment 2:Painting objects with Gradient and enhancing colour values
Experiment 3. Applying black and white ecffect to perticular object in image.
Experiment 4. Applying motion filter effect.

Experiment 5:Implementation Lens flare, colour lense & light reflection
Experiment 6. Applying dispersion effect.

Experiment 7. Implementation of water illusion effect.


http://www.amazon.com/s/ref=dp_byline_sr_book_1?ie=UTF8&amp;text=Laurie+Ann+Ulrich&amp;search-alias=books&amp;field-author=Laurie+Ann+Ulrich&amp;sort=relevancerank
http://www.amazon.com/Lesa-Snider/e/B00376ZIHO/ref=dp_byline_cont_book_1

Experiment 8.Creating Gallery

T.Y.B.VOC COURSE: BVS/BVT 5.02
Title: ENTREPRENEURSHIP (Part I)

Learning Objectives:
To equip students with knowledge of creating, establishing, managing, developing or pruning
enterprises, either of their own or to understand enterprises that they will be dealing.

Total Lectures: 60

UNIT 1: The Entrepreneurial Evolution 20 lectures
e Nature & Development of Entrepreneurship.

e The Entrepreneurial Decision Process.

e Venturing- New Venture Formation.

e Types of Enterprises.

¢ Role of Entrepreneurship.

e The Entrepreneurial & Intrapreneurial Debate.

e Identifying & Evaluating Opportunity for Enterprise Development.
e Resource requirement to set-up & start-up & operate Enterprise.

e Strategic/Tactical/Operational orientation of establishing Enterprise.
e Management Structure.

e Entrepreneurial background & characteristics.

e Role modeling of successful entrepreneurs.

e Cross border Entrepreneurship.

e C(Case Studies.

UNIT 2: Creativity in Enterprise 20
lectures

e Idea Generation.

e Creative Problem Solving.

e Product Identification & Development.

e Technology in Enterprise establishment.

e Enterprise as a multi-dimensional enitity.

e The Business Plan.

e The Functional Plan.

UNIT 3: Start-up establishment of Enterprise 20
lectures
e Sources of Funding.



Venture Capital.

Risk evaluation of Enterprise.
Enterprise valuation.

Leading and Managing the Enterprise.
Growth Strategies.

Exiting the Enterprise.

Ending the Enterprise.

Evaluation:

CIA 1 (20 marks): Class Test
CIA 2 (20 marks): Project/Assignments
End Term Exam: 60 marks (Written exam)

TEXT BOOKS:

Entrepreneurship — 6™ Edition. Robert D Hisrich, Michael P Peters, Dean A
Shepherd.McGraw-Hill.

Entrepreneurship — David Stokes, Nick Wilson, Martha Mador.South-Western Cencage
Learning.

REFERENCES:

The Oxford Handbook of Entrepreneurship — Mark Casson, Bernard Yeung, Anuradha
Basu, Nigel Wadeson. Oxford University Press.

Entrepreneurship in India. Dr Sanjay Tiwari, DrAnshujaTiwari. Sarup& Sons.
Entrepreneurship Development in India. Sami Uddin. Mittal Publications.

Dynamics of Entrepreneurial Development & Management - Vasant Desai. Himalaya
Publishing House.

Patterns of Entrepreneurship Management. 3™ Edition. Jack M Kaplan, Anthony C
Warren. John Willey & Sons Inc.



T.Y.B.VOC BVS/BVT
5.03
Title: PSYCHOLOGY
Learning Objectives:
e To enhance the thinking, emotions, communication and interpersonal skills of students so
that they can be good at customer handling and services.
e Enable them to maintain a healthy work-life balance.

Total Lectures: 60

Unit 1: Understanding the Self 15 lectures
e Self esteem and Subjective well being
e Positive Thinking and Optimism
e Creative Thinking, Problem Solving and Decision Making
e Goal setting and Time management
e Motivation
¢ Emotional intelligence

Unit 2: Working with others 15 lectures
e Communication (Verbal and Non Verbal)
e Empathy and Listening skills
e (Giving and receiving Feedback
e Conflict Management
e Team Building and Team work

Unit 3: Customer Satisfaction 15 lectures
e Psychology of customer service: Creating and sustaining customer relationships
e Product knowledge
e Sales and its relation with customer satisfaction
¢ Handling complaints

Unit 4: Balancing work and life 15 lectures
Work Life Conflict
e Impression Management

Job satisfaction and Employee satisfaction
e Stress Management
Evaluation:
e CIA 1 (20 marks): Class Test
e CIA 2 (20 marks): Assignments
e End Term Exam: 60 marks (Written exam based on case study analysis)
References



Feldman.R.,(2016), Understanding Psychology ,Tenth Edition, McGraw Hill Education
Pvt.Ltd, India.

Kumar.V., (2008), General Psychology, Himalaya Publishing House ,India.

Weiten.W., Hammer.E.& Dunn.D.,(2009), Psychology and Contemporary Life: Human
Adjustment,Wadsworth,Cenagage Learning, USA.
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Skill Component courses

Theory Course Syllabus for:
S.BVS.5.04 Mobile App Development using Android 11
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S.BVS.5.PR
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B.Voc (Software Development) Semester V Course: S.BVS.5.04

ADVANCED ANDROID PROGRAMMING

Learning Objective: To master the Android developement using Advanced programing
features using,XML,Hypertext and scriting and desktop language.

[Total Lectures 60]

UNIT 1: Android Device Integration [7]

CameraApp, Camera Recording, Bluetooth,WIFI, Contacts,Audio Capture,
Theme/style.Thread.

UNIT 2:CustomeGesture [7]

CommonGesture, TouchEvent, MotionEvent, PinchExample, ClipBaord,
ImplicitIntent, TransitionDemo, NewDrawer Demo, Scene Transition

UNIT 3:Android API using HTML & script [6]

Online Website, Offline website, Android event with Javascript,
WebViewClient/ WebChromeClient, File reading, Fragment Example

UNIT 4: Database, fonts & Explicit events [15]



SQlite Database, MaterDetailsFlow, Contact list database, Custom font, ClipBaord,
CardDemo,

Card Demo, AppBar, FabExample, ExplicitEvent, CustomePrintDatabase, StorageDemo

UNIT 5:Location Based Services [15]

Network Connectivity, GPS, Google Map, Permission Manager, Local Bound, Remote
Bound, Send Broadcast, Broadcast receiver

Continuous Internal Assessment
Assignments / Project

Mid Term test.

List of Text Books:
1. Android Design Pattern:Interaction Design Solution for Developers.(By: Greg Nudelman )

2. Programming Android-(By: Zigurd Mednieks, Laird Dornin, G. Blake Meike & Masumi
Nakamura )



B. Voc. (Software Development) Semester — V COURSE : S.BVS.5.05

ASP.NET

LEARNING OBJECTIVE:

To equip the students with skills required in software industry.
Students will learn the latest of ASP.NET in framework 4.x/5.x.

Students can apply the skill learnt in developing website or application.

[Total Lectures 60]

Unit 1. Introduction, Controls, Event and web service [20]
Introduction:

- Understanding Visual studio IDE environment
1) Design view
2) Source view
3) Output window
4) Error list window
5) Intellisense
6) Property window
7) Object Browser window
8) Start page
9) Toolbar and Toolbox

- ASP.NET life cycle.
- Common Language Runtime (CLR) architecture.
- Using .NET Framework Class Library.

Different Controls: Introduction to control class, TextBox control,
Button Control, Label Control, Image control, ImageButton control,

ImageMap control, DropDownlList control, CheckBox control, RadioButton

control,

Table control, Calendar control, SiteMap control, TreeView control, = Menu control, Validation

controls, Login controls, Database controls.



Windows Presentation Foundation (WPF).

Event handling: Application_Start, Application_End, Page_Load , Page_Unload, Click event
:0nClick , TextChanged event: OnTextChanged , Command event: OnCommand ,

CheckedChanged event: OnCheckedChanged , SelectedindexChanged event:
OnSelectedindexChanged, postback events

Using event argument etc.

Web service: What is a web service? SOAP and Web service. Creating web service,
consuming web service.

Unit 2. Validation, Navigation, and Ajax in ASP.NET [20]

Validation Control: Introduction, basic validation controls, validation techniques, using
advanced validation controls like:

Regular Expression Validator Control, Compare Field Validator Control
Range Validator Control,Validation Summary Control, Custom Validator Control

State Management: Using view state, using session state, using application state, using
cookies and URL encoding.

Master Pages: Creating master pages, content pages, nesting master pages, accessing
master page controls from a content page.

Navigation: Understanding Site Maps, Using the Sitemap Path Control, Formatting the
Sitemap Path Control, Using the Menu Control, Using Tree View Control.

Ajax: Introducing AJAX, Working of AJAX, Using ASP.NET AJAX server controls.

Unit 3. Database with ADO.NET, LINQ and Crystal Report [20]
Database Elements:

1) ADO.NET Object model

2) Data Binding

3) Using Connection, Command,

4) DataReader classes, Queries returning result sets

5) Passing parameters in queries

6) Using Repeater control

7) Data Adapter, Using Data Set (Typed), Data Table, Data Row & Data Column
8) Introducing the ADO.NET Entity Framework.



9) Mapping Your Data Model to an Object Model
10) CRUD with ASP.NET
11) Authentication and Authorization with ASP.NET

LINQ:

1) Introducing LINQ and its Architecture
2) LINQto Objects

3) LINQto XML

4) LINQto ADO.NET

Crystal Report:

1) Adding a Crystal Report to an ASP.NET Application

2) Inserting Fields, Text, and Special Fields
3) Sorting, Grouping, and Subtotaling

4) Using Select Expert

5) Dynamic Formatting

6) Using the Crystal Reports Viewer

Continuous Internal Assessment
Assignment on unit 1, unit 2, unit 3
Mid Term Test.
BOOKS:
1) ASP.NET 4.0in simple steps dreamtech press
2) Murach’s ASP.NET 4 Web Programming with C# 2010, 4th Edition, Anne Boehm, Joel
Murach, SPD.

3) Integrating Crystal Reports into an ASP.NET Application
By Vincent Varallo Wrox Publication

REFERENCES:

1) ASP.NET —The Complete Reference Tata McGraw Hill.
2) Beginning ASP.NET 4: in C# and VB by Imar Spaanjaars Wrox Publication.
3) C#and .NET 4 by Christian wrox publication.

RESOURCE:

http://www.tutorialspoint.com/asp.net



B. VOC (Software Development) SEMESTER V BVS.5.PROJ
PROJECT-1

[Total Lectures 180]
Project will carry 6 credits with 200 Marks.
Students can do live project in industry or in-house project.

Students are expected to give time equivalent to 12 lecture periods/week, out of which 3 periods

will be contact time for guidance from internal guide. There will be continuous internal
assessment (CIA) for 40% of the credit (80Marks).

This will consist of:

CIA 1> assessment of synopsis and viva on it

CIA 2-> analysis of requirement gathering, system design including DFD,
Use case, ER, Normalization, Context level diagrams etc.

Remaining 60% of the credit (120Marks) will be end semester examination consisting of
documentation, presentation and viva. This will be jointly examined by the project guide
and external examiner under the subheading of marks as follows:

Documentation Presentation viva | Execution of System design
various modules understanding
(validation, database
handling) with report and
testing
30 30 20 30 10

List of project categories

1) Hardware projects based on microcontroller / PIC

2) Networking projects

3) Mobile projects

4) Wireless technologies

5) Website projects

6) Desktop application

7) Real-time application in Linux/ Unix

8) Or any other suitable project which is approved by the project guide



Suggested format for project report S.BVS.6.PROJ

1) Cover page
2) Certificate from college(for in-house / external project)
3) Synopsis of project
4) Project report
a) Table of content
b) Definition of problem
c) Objective and scope of project
d) System analysis and design
1) User requirement
* Functional requirement
= Non-functional requirement
i) Normalization
1i1) DFD, context level diagrams
v) Flowchart, ER diagram
V) Use case diagrams
e) Feasibility study
1) Technical feasibility
i) Economical feasibility
iii) Operational feasibility
f) Software engineering paradigm applied
g) Software and hardware requirement specification
h) PERT chart, Gantt chart
1) Coding
J) Code efficiency
k) Validation checks
1) Testing
Test techniques(white box and black box testing)
Writing Test cases
Using test data
Generating defect reports
e Use of testing tools(manual/automated)
m) System security measures
n) Cost estimation of project
o) Reports
p) Screen shots
q) Future enhancement
r) Bibliography
s) Glossary
5) Students have to submit black book to college(1 per group) in A4 size with one side
written (approx 150-200 pages) along with CD having full documentation and codes

6) Students doing project in industry will have to get certificate from the company.



B.VOC (Software Development) SEMESTER V BVS.5.PR

ANDROID Practical List:

Learning Objective:

To introduce the concept android programming and develope app using android development
studio.

List of Practicals:

Experiment 1.Android Camera App(Customized preview)
Experiment 2: Android Voice Recording App

Experiment 3. Video Recording app

Experiment 4: Common Gestures

Experiment 5: Android Text to speech

Experiment 6.Bluetooths scanner App/Barcode Reader
Experiment 7.WI-FI Scanner & pairing

Experiment 8.Sqlite Database to add,find &delete(Contact List) etc

ASP.NET PRACTICALS

LEARNING OBIJECTIVE:

To equip the students with skills required in software industry. Students will learn the latest of
ASP.NET in framework 4.0/4.x. Students can apply the skill learnt in developing website or
application with practice from practical.

Attempt any 8 practical’s from the list.

Practical No 1:



Create a simple Web Service that converts the temperature from Fahrenheit to Celsius, and vice
versa create a simple Web Service that converts the temperature from Fahrenheit to Celsius, and
vice versa. Also write an ASP program to consume this web service.

Practical No 2:

Design a Ul and use validator for following conditions
- A password which is entered twice for confirmation
- The age of the user to be over 21

- The date to be after the 10/10/2000

Practical No 3:

Design a Login screen in ASP.NET which accepts user name and password. On submit it should
check from the server whether the user exists or not . If the user exists in web server then he/she
should be directed to proper web page with welcome message.

Practical No 4:

Write the following application.

The initial page is called Validator.aspx and it has 7 text boxes representing
(Name, Family Name, Address,City, Zip Code, Phone and e-mail address)
and a Check button.

User gets the following page after clicking on Check button:



~Validators - Microsoft Internet Explorer

File Edit View Favorites Tools Help
Q- © ¥ B @ Prsewch Joroones @ (-5 w - [ JE |
Address é] http:/flocalhost:4811 /class4/Validator1,aspx
Google |G~ vleo o @ B~ €% Bookmarksw & 13blocked S Check v 'y Autolinl
the Page is Valid
Insert your details :
Name: In
Family Name: ]a ‘ differs from name
Address: Ianan at least 2 chars
City. |asdasda at least 2 chars
Zip Code: |12345 (%)
Phone: |09-1234567 (- RoRo. { KRR - KRR
E-Mail: Ia@a.com example@example.com | Check |

The required validation actions are:
¢ name different from family name,
e address at least 2 letters,

e city at least 2 letters,

e zip-code 5 digits,

e phone according to the format XX-XXXXXXX or XXX-XXXXXXX,



e ¢-mail is a valid email.

After entering some of the details correctly user gets the following message:

a Validators - Microsoft Internet Explores

Fie £ Favarts Toxs el

O - @ (¥ @ @ Pswsr Sorovonss @ (3-45 o - )
Adchess | ) htpsiflocahost: 481 1 fdass4Valdator 1 aspx = =——
Google |G~ v|wed B~ O scohmase Bi13bloded W Check v
Insert your details

Name: In

Family Name a iffers from name

Address: fasdesd at least 2 chars

City |asdasda at least 2 chars

Zip Code: 123 ** (3o00ex)

Phone |1234 - (XR-3000000K | 3000-30000RKE)

E-Mai wer2.com " example@example.com

And after a correct submission of all the details:



|27 Vahdators - Microsoft Internet Explorer
Fie Edt View Favorites Tools Help

Om- O 8 @G P Szreens @3- = -LJK

8] tetp Iocahost:4611/cass4/Valdator . aspx
Google (G~ viGoog B - sockmdsy B 13blced W Check vy, Autolind
the Page s Vald
Insert your detads
Name In
Faruly Name: |a differs from name
|
Address oo at least 2 chars
Caty lasdasds at least 2 chare
Zip Code: {12345 (so0ox)
Phone 1091234567 (xx-3cocoon: / ox-oonoox)
E-Mad [si@a.com | Check

Practical No 5:

Create ascreen which accepts student rollno . On click of submit it should display student result in
the gridview with fields

Name Course Marks TotalMarks Percentage

The database table contains table called student( rollno, name, course , address, year)

Result(rollno,subject,marks, totalmarks)

Practical No 6:

Using crystal report design simple marksheet for SSC result. The data should appear dynamically
form database.



Practical No 7:

Design Ul for credit card data entry. User writes all the details such as card no(16 digits) expiry date
CVV no etc. These details should be validated using validators and database for appropriate fields.
After verification it asks for amount of transaction with password. If amount < balance display
insufficient balance else display page which tells transactions successful.

Practical No 8:

Create a Web application that illustrates the use of themes and master pages with Site-Map. And
create a web page with CSS.

Practical No 9:

Write a Program in ASP that has a form taking the users name as input. Store this name in a
permanent cookie & whenever the page is opened again, then value of the name field should be
attached with the cookie"s content.

Practical No 10:

Demonstrate user’s Authentication and Authorization in ASP.NET

Practical No 11:

Demonstrate the use ad-rotator to change advertisements on client side request.

Practical No 12:

Create a small online quiz application which displays the set of questions (differently to different
users) based on the authentication and subject selection. At the end it displays the marks scored by
candidate. Also it doesn’t allow any page view without authentication (use session concept).

Practical No 13:

Create a registration form for students and demonstrate CRUD operation on it in ASP.NET.



Practical No 14:

Demonstrate use of System.Collections.Generic to store the details of students with Id, Name,
Course, and D.O.B etc. Now store these details in database using Collection. Add search feature
which searches record as per id.

Practical No 15:

Create a web application to insert 3 records inside the SQL database table having following fields (
Deptld, DeptName, EmpName, Salary). Update the salary for any one employee and increment it to
15% of the present salary. Perform delete operation on 1 row of the database table.

Continuous Internal Assessment

Conducting practical test



N
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General Education Component

T.Y.B.VOC Course: BVS/BVT 6.01

Title: Popular Culture
Learning Objectives:

1. To introduce students to the different understandings of Popular Culture.

2. To combine a theoretical and artefactual study through case studies.

Number of lectures: 60
Unit 1: Introduction
e What is culture?
e  Why study culture?
e How culture matters: Amartya Sen
Unit 2: Popular Culture
e Meaning & Definitions
High Culture and Low Culture
Mass Culture and Folk Culture
Culture Industry
Unit 3: Popular Music

e America

e Britain

e India

e Middle East
e Africa

12 lectures

12 lectures

12 lectures

Unit 4: Popular Culture & Social Representations (Screenings & Discussions) 12

lectures

e Race: Reel Bad Arabs

e Gender: Women in Indian Cinema

e Caste in Indian Popular Films: Fandry, Masaan, Sairat

e Bombay & The Working Class: Popular Literature, Theatre, Films, Songs

Unit S: Important Trends and Debates

e (Class and Cultural Consumption

e Introduction to Fandom: Why Study Fans?
e Cultural Economy of Fandom

e Fashion
e Subculture: The Meaning of Style
Evaluation:

e CIA 1 (20M): Test;
e CIA 2 (20m): Assignment/ Presentation on Unit 3
e ESE (60 M): Written test

12 lectures



Suggested Readings:

1.

2.
3.

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

Appadurai, A. (1997). Modernity at Large: Cultural Dimensions of Globalisation.
Delhi: Oxford University Press.

Fiske, John. The Cultural Economy of Fandom

Gokulsing, K. M. and W. Dissanayake (eds.). (2009). Popular Culture in a
Globalised India. Oxon & New York: Routledge.

Gray, J., Sandvoss, C., and Harrington, C.L. (Eds.). 2007. Fandom: identities and
communities in a mediated world. New York: NYU Press.

Grindstaff, Laura. (2008). “Culture and Popular Culture: A Case for Sociology.” In
Annals of the American Academy of Political and Social Science, 619: 206-222.
Grossberg Lawrence. Is There A Fan In The House? The Affective Sensibility of
Fandom

Guins, Raiford et al (eds.) (2005). Popular Culture: a Reader. London: Sage Pub.

Hebdige, Dick (2002). Subculture: The Meaning of Style. London & New Y ork:
Routeledge

Hermes, Joke. (2005). Re-reading Popular Culture. Oxford: Blackwell Pub.

. Kasbekar, Asha. (2006). Pop Culture India! Media, Arts and Lifestyle. Santa Barbara:

ABC-Clio.

Kelly, William (2004). Locating The Fans. Albany: State University of New York
Press

Lewis, Lisa (ed). (1992). The AdorningAudience: Fan Culture and Popular Media.
London & New York: Routledge

Parker, Holt N. (2011). “Toward a Definition of Popular Culture.” In History and
Theory 50: 147-170.

Rege, Sharmila. (2002). “Conceptualising Popular Culture: The Lavni and Pawda in
Maharashtra,” Economic and Political Weekly. 37 (11): 1038 — 1047.

Storey, John. (2003). Inventing popular culture : from folklore to globalization.
Oxford: Blackwell Pub.

Storey, John. (2009) Cultural Theory and Popular Culture: An Introduction. Fifth
Edition. New Delhi: Pearsons

Storey, John (ed). (2009) Cultural Theory and Popular Culture: A Reader. Second
Edition. Athens: University of Georgia Press

Strinati, Dominic. (1995). An introduction to theories of popular culture. London:
Routledge.

Weaver, John A. (2005). Popular culture primer. New York: Peter Lang Publishing,
Inc.

Williams, Raymond (1983). Keywords: A Vocabulary of Culture & Society. New
York: Oxford University Press

Williams, Raymond (1989a). Culture Is Ordinary. Resources of Hope: Culture,
Democracy, Socialism. London: Verpo, pp. 3-14



TYBVoc T. Y. B.VOC Course: BVS/BVT 6.02
Title: ENTREPRENEURSHIP (Part II)

Learning Objective:

To equip students with knowledge of creating, establishing, managing, developing or pruning
Enterprises through the practice of Management.

Total lectures: 60

Unit 1: Enterprise and Entrepreneurship 20 lectures

e Qualities- Skills- Responsibilities- Role- Resources - Levels

e Functional areas of Management (Contexts of Finance- HR- Marketing- Manufacturing-
etc.)

e Personality- Attitudes- Work Behaviour- Ability- Values- Job Performance

e Organizational Citizenship- Organizational Performance.

e History and Trends in Entrepreneurship

¢ Globalization

e Value-based Leadership

Unit 2: Principles of Management 10 lectures

e Management Ideas

e Learning Organization

¢ Culture and Cross-Cultural understanding

e Ethics

e Developing Mission- Vision- Values

e P-O-L-C (Planning-Organizing-Leading-Control)

e Creativity- Passion- Stakeholders

Unit 3: Strategizing 10 lectures

e Strategic Management Process- Corporate Strategy-

e SWOT- Internal Analysis Tools. External Analysis Tools- Strategic Focus.

e Porter’s Generic Strategy.

e Value Discipline. Value-Chain- VRIO Blocks (Value-Rarity-Inimitability-
Organizational).

e 5-Forces. STEPLE.

e Strategy Diamond.

Unit 4: Principles of Organisation 20 lectures



e Goals- Objectives- MBO- Balanced Score-Card- Integrating Goal/Objectives with
Performance Evaluation- Sustainability Index- Competencies- Motivation- CSR-
SMART criteria

e Organization Structures & Change- Establishing Balance- Formalization- Hierarchical
Levels- Departmentalization- Functional/Divisional- Impact of Technology- Resistance
to Change- Planned change

e Organization Culture- Elements of Culture- Characterizing- Dimensions- Cultural
Development & Maintenance

e Social Networks- Sociogram- Actors- Informational ties- Types of Social Networks-
Innovation Network- Social Network Analysis- Personal/Operational/Strategic
Networks- Mapping

Evaluation:

e CIA 1 (20 marks): Class Test

e CIA 2 (20 marks): Project/Assignments

e End Term Exam: 60 marks (Written exam)

TEXT BOOKS:
Management Fundamentals - Management & Entrepreneurship: Concepts, Application, Skill-
Development. Robert N Lussier. South-Western Cengage Learning. 4" Edition.

REFERENCES:

1. The Oxford Handbook of Entrepreneurship — Mark Casson, Bernard Yeung,
AnuradhaBasu, Nigel Wadeson. Oxford University Press.

2. Entrepreneurship in India. Dr Sanjay Tiwari, DrAnshujaTiwari. Sarup& Sons.

3. Entrepreneurship Development in India. Sami Uddin. Mittal Publications.

4. Dynamics of Entrepreneurial Development & Management - Vasant Desai. Himalaya
Publishing House.

5. Patterns of Entrepreneurship Management. 3™ Edition. Jack M Kaplan, Anthony C
Warren. John Willey & Sons Inc.

TYBVOC COURSE: BVS/BVT 6.03

Title: BUSINESS ETHICS
Learning Objectives:
To equip students with knowledge of ethics in creating and managing enterprises or
organizations.

Total lectures: 60



Unit 1: Introduction 05 lectures
e Overview of Business Ethics.
¢ Differentiate between Rules/Policies/Law & Ethics.
e Ethics & Social Responsibility.
¢ Evolution of Ethics in Business.
e Purpose of Business Ethics.

Unit 2: Elements of Business Ethics 10 lectures
¢ FEthical Issues in Business.

e Causes & Influences of Unethical Behaviour.

e Organizational misconduct.

e C(lassification of Ethical issues.

e Conlflict of Interest- Honesty & Fairness.

¢ Organizational Relationships.

e Ethical Issues related to Ownership.

¢ Financial Responsibilities.

e Employees & Management Concern.

e Consumer & Marketing Issues.

e How to identify an Ethical Issue.

e Applying Moral Philosophies to Business Ethics.

e Teleology- Deontology- Relativist Perspective- Virtue Ethics- Types of Justice.

Unit 3: Issues in Ethical Decision Making 15 lectures
e Social Responsibility- Business Ethics in Social Responsibility- The Legal dimension.
e Disputes in Business Ethics. Dispute Resolution.

e The Ethical dimension. Managing Ethics Programs.

e The Economic dimension.

e The Philanthropic dimension.

e Ethical Issue Intensity.

e Statutory Requirements- Cognitive Moral Development- Kohlberg's Model.

e Corporate Culture. Ethical Climate significance.

e Stress influence on Ethics.

e Opportunity influence on Ethical Behaviour.

e Business Ethics Evaluation & Intentions.

Unit 4: Influences and Conflicts 15 lectures
e Organization Structure and Ethical Decision Making.

e Ethical Issues in Centralized Organizations & Decentralized Organizations.

e Role of Corporate Structure in Ethical Decision Making.

e Cultural differences influencing Ethics.

e Key Influences in Ethical Behaviour.
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B. Voc. (Software Development) Semester — VI

ENTERPRISE RESOURCE PLANNING WITH SAP

Learning Objective:

COURSE :S.BVS.6.04
& Course: S.ITS.6.02

To introduce the concept of ERP systems along with SCM’s structures and special focus on

Material Management module along with SAP Business One software demos as a learning

tool.

Number of lectures: 60
UNIT 1

ERP-An Introduction
What is ERP?

The Need for ERP, Benefits of ERP,

Business Models, Growth of ERP in India
ERP Implementation Lifecycle introduction
Vendors, Consultants & Users

In-house Implementation Pros and Cons,

Vendors, Consultants, End-Users

UNIT 2
Supply Chain Management — I

Introduction —
What is Supply Chain? Its objective,
Supply Chain Decision making,
Process View of a Supply Chain,

Examples of Supply Chains

(10 lectures)

(10 lectures)



The Network —
The Role of Distribution in the Supply Chain,
Factors that influence the Distribution Network Design,
Design Options for a Distribution Network,

E-Business and the Distribution Network,

Channels of Distribution, Distribution Networks in Practice.

UNIT 3
Supply Chain Management - 11

The Customer service dimension —

Customer Service and Customer Retention,

Service driven logistics systems,

Setting customer service priorities and service standards
Benchmarking the Supply Chain —

Benchmarking the logistics process,

Mapping supply chain processes,

Supplier and distributor benchmarking,

Setting benchmarking priorities, performance indicators

UNIT 4

ERP Modules
Finance, Sales and Distribution,
Human Resource Management,

Material Management

(10 lectures)

(10 lectures)



UNIT 5 [Text Book 4. Chap 2]

Materials Management organizational structure in SAP (10 lectures)

Client Structure, Company
Plants, Storage Locations
Warehouse and storage Types
Purchasing Organization

Business Examples — Organizational Structure

UNIT 6 |[Text Book 4. Chap 20. 21, 22] (10 lectures)

Inventory Management
Goods Movements, Goods Issue,
Goods Receipt, Physical Inventory
Returns, Reservations, Stock Transfers,
Business Examples.

Goods Issue
To Production Order, To Scrap,
For Sampling, Posting, Reversal,
Business Examples.

Goods Receipt
For a Purchase Order, For a Production Order,
Entry of inventory, Other Goods Receipts,
Business Examples

Continuous Internal Assessment

Assignments on unit 1-4 / Mid Term Test / Case Study of ERP implementation
Midterm test

List Of Text Books




3.
4.

“ERP”, Alexis Leon, Tata McGraw Hill.

“Supply Chain Management Strategy, Planning and Operation”, S Chopra, P. Meindl
and D. Kalra, Pearson.

“Logistics and Supply Chain Management”, Martin Christopher, Pearson.

Materials Management with SAP ERP, 3" Edition, Martin Murray, SAP PRESS.

List Of Recommended Reference Books

1.
2.

Alexis Leon, “ERP Demystified”, Tata McGraw Hill
“Enterprise Resource Planning”, E. Monk, B. Wagner, Cengage Learning



B. Voc. (Software Development) Semester — VI COURSE : S.BVS.6.05

& Course: S.ITS.6.03
SOFTWARE TESTING
Learning Objective:

To develop the skill of software testing
Number of lectures: 60
UNIT 1 [08]

The basics of software testing

Terms and Motivations:

Error and Bug Terminology, Testing Terms, Software Quality
The Fundamental Test Process

Test Planning and Control,

Test Analysis and Design,

Test Implementation and Execution,

Evaluation of the Test Exit Criteria and Reporting,

Test Closure Activities

UNIT 2 [12]

Testing in software life cycle

The General V Model

Component Test:

Explanation of Terms, Test Objects, Test Environment, Test Objectives, Test Strategy,
Integration Test:

Integration Strategy, System Test,

Acceptance test:

Testing for user acceptance, Operational testing, Field testing, alpha testing and beta testing,
Static testing, Foundations, Review,

Walkthroughs, inspections

The General Process, Roles and Responsibility and Types of Review

UNIT 3 [08]

Functional testing

Boundary value analysis testing,
Robustness testing,

Worst case testing,

Equivalence class testing,

Decision table based testing,

Cause effect graphing technique and
State transition testing.



UNIT 4 [12]
Structural testing

Control flow testing,

Statement coverage,

Branch coverage,

Conditional coverage and path coverage,

Data flow testing,

Basis path testing, cyclomatic complexity,

Mutation testing, mutation and mutants,

Mutation operators and mutation score and slice based testing

UNIT 5 [08]

Test Management

Test Organization:

Test Teams, Tasks

Test Planning:

Quality Assurance Plan, Test Plan, Prioritizing Tests
Cost and Economy Analysis:

Cost of Testing, Test Effort Estimation

Definition of Test Strategy:

Preventive Vs Reactive Approach,

Analytical vs. Heuristic Approach

UNIT 6 [12]

Advanced concepts of software testing

Metrics and models in software testing,

Software metrics, categories of metrics,

What should be measured during testing?

Testing web applications,

Functional testing, user interface testing, navigation testing and form based testing,
automated test data generation using genetic algorithm, initial population, Crossover and
mutation, fitness function and algorithm for generating test data.

List Of Text Books
1. Software Testing by Y ogesh Singh
List Of Recommended Reference Books
1. Software testing foundations — Andreas Spillner , Tilo Linz , Hans Schaefer (SPD
publication)
2. Software Testing —Ron Patton second edition
Software engineering — A Practitioners Approach by Roger s Pressman

(98]

4. Software testing —Principles ,Techniques and Tools - Tata Mc-Graw Hill education
Pvt . Ltd ,New Delhi



SEMESTER VI COURSE : S.BVS.6.PROJ

PROJECT- 11

[Total Lectures 180]

Project will carry 6 credits with 200 Marks.
Students can do live project in industry or in-house project.

Students are expected to give time equivalent to 12 lecture periods/week, out of which 3 periods
will be contact time for guidance from internal guide. There will be continuous internal
assessment (CIA) for 40% of the credit (80Marks).

This will consist of:

CIA 1-> assessment of synopsis and viva on it

CIA 2-> analysis of requirement gathering, system design including DFD,
Use case, ER, Normalization, Context level diagrams etc.

Remaining 60% of the credit (120Marks) will be end semester examination consisting of
documentation, presentation and viva. This will be jointly examined by the project guide
and external examiner under the subheading of marks as follows:

Documentation Presentation viva | Execution of System design
various modules understanding
(validation, database
handling) with report and
testing
30 30 20 30 10

List of project categories

1) Hardware projects based on microcontroller / PIC
2) Networking projects

3) Mobile projects

4) Wireless technologies

5) Website projects

6) Desktop application

7) Real-time application in Linux/ Unix




8)

1)

3)
4)

Or any other suitable project which is approved by the project guide

Suggested format for project report S.BVS.6.PROJ

Cover page
Certificate from college(for in-house / external project)
Synopsis of project
Project report
a) Table of content
b) Definition of problem
c) Objective and scope of project
d) System analysis and design
1) User requirement
» Functional requirement
* Non-functional requirement
1) Normalization
1i1) DFD, context level diagrams
1v) Flowchart, ER diagram
V) Use case diagrams
e) Feasibility study
1) Technical feasibility
1) Economical feasibility
1i1) Operational feasibility
f) Software engineering paradigm applied
g) Software and hardware requirement specification
h) PERT chart, Gantt chart
1) Coding
j) Code efficiency
k) Validation checks
) Testing
e Test techniques(white box and black box testing)
e Writing Test cases
e Using test data
e Generating defect reports
e Use of testing tools(manual/automated)
m) System security measures
n) Cost estimation of project
o) Reports
p) Screen shots
q) Future enhancement
r) Bibliography
s) Glossary



5) Students have to submit black book to college(1 per group) in A4 size with one side
written (approx 150-200 pages) along with CD having full documentation and codes

6) Students doing project in industry will have to get certificate from the company.

B.VOC (Software Development) SEMESTER VI

Practicals Course: S.BVS.6.PR

Title: Enterprise Resource Planning with SAP
Learning Objective:
To introduce the concept of ERP systems to students with the help of case study simulation

tutorials using SAP Business One software demos as a learning tool.

Practical List:

1. Case study on Purchase Order

2. Case study on MRP

3. Case study on Sales Order

4. Case study on Warehouse management

5. Case study on Bill of Materials

6. Case study related to Goods movement

7. Case study related to Invoice handling.

PRACTICALS IN SOFTWARE TESTING S.BVS.6.PR

Software Testing
Learning Objective:
To develop the skill of Software Testing

Software Testing practicals



I) Basis path testing

IT) Component testing

[IT) Data flow analysis test

IV) Equivalence class partitioning test
V) Boundary value analysis test
VI) Robustness based testing
VII) State transition testing
VIII) Decision table based test
IX) Branch condition test

X) Mutation test

XI) Navigation test

XII) Data based test

XIII) Form based testing

XIV) Slice based test

XV) Testing using tools



